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Limitations on Maintenance Services

The FactorSoft™ application is intended for use in accordance with the standards and processes described within this
documentation. Efforts to investigate and/or repair FactorSoft™ application or data integrity issues caused by activ-
ities or integrations outside of the intended use of the FactorSoft™ platform will be subject to the then-current Jack
Henry Professional Services billable hourly rate.

Standard Maintenance Services (Technical Support) does not include the following:

Investigation and Remediation of errors and data integrity issues caused, contributed to, or by any of
the following:

n a software program that was not originally provided by Jack Henry

l third-party automation, BOT/Screen Scraping technology, custom importers,
or any other integration with FactorSoft™ that was not created by or in con-
junction with Jack Henry.

n any modification not provided by Jack Henry to the software or standard database
schema

l the addition of custom database elements including triggers, stored pro-
cedures, tables, and columns

l the alteration of standard FactorSoft™ triggers, tables, columns, stored pro-
cedures and indexes

l the execution of T-SQL scripts resulting in changes to the data stored within
the FactorSoft™ database

n equipment, software, networks or any other infrastructure in the customer’s envir-
onment that does not meet the minimum requirements described within the then-
current FactorSoft™ product documentation

Please note that if you are exploring possibilities with third-party software providers or considering altering the FactorSoft database
in any way, it is strongly recommended that you discuss your plans with the FactorSoft™ support team before making any com-
mitments or changes. As your software partner, we may be able to help solve your business problem in a way that does not intro-
duce risk, data corruption, or system instability.
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AutoInvoice Interface Specifications

AutoInvoice can be used to automate the data entry and scanning of images and data associated with
invoices and purchase information. The invoice importer can import invoices, images (including multi-
page PDFs), and corresponding details (including debtor and relationship information) into FactorSoft.

AutoInvoice is used along with the FactorSoft Invoice Importer Engine XML or Stand-alone Executable to
import purchase batches in various supported formats. The XML Importer, Stand-alone program and sup-
ported file descriptions are discussed in detail in this guide.
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Setting Up AutoInvoice

This section shows you how to set up FactorSoft to allow purchase imports via AutoInvoice.

System Preferences

The following System Preferences must be set in the Identification/system constants, Performance,
Scanning:

Preference Description

Store scanned
images in files

Set to True to store imported images in files. This preference must be set to
True to import image files in AutoInvoice.

The following System Preferences must be set in the Data entry behavior, Purchase entry, Batch control:

Preference Description

Auto Invoice API does
not require approval

Set to True to mark all batches imported through AutoInvoice as approved.

Auto Invoice API uses
(Scanned/ Ready to
Post) as batch
released status

Set to True to set all batches imported through AutoInvoice that do not have
rework conditions to Scanned/Ready to Post status.

Auto Invoice API
updates Pay by
Method on batch
transaction

Set to True to indicate that the Pay By method is set for the batch when impor-
ted.

The Pay By is selected at purchase by the following sequence: 1) the program
looks up the client’s default bank account Pay By method, 2) if no default bank
account is set, the Pay By method is set to CHECK, 3) if the API provides the cli-
ent bank account in the payout record, the program retrieves the Pay By
method from that client bank record.

The following System Preferences must be set in the Data entry behavior, Imaging:

Preference Description

Daily folder root path Enter the root path for the daily folder used to store images.

Use daily folders for
images

Set to True to store images in the root path defined in the system preference
Data entry behavior, Imaging, Daily folder root path.
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After defining the system preferences for imaging, the first daily must be created and the path name
must be entered on the Image Folder Maintenance screen in the Administration module.

NOTE
The Image Folder Maintenance screen can be accessed by selecting System → Database Main-
tenance → Image Folder Maintenance.

When entering the menu path, the server name should be used. For example, \\Bhm-QAAlpha\cadence-
share\ images\2017\07\11.

The next daily folder is automatically created by the Engine during the Date Roll process.
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FactorSoft Invoice Importer Engine

The Engine XML Invoice Importer is used for importing a specific XML file using the FactorSoft Engine as well
as purchase uploads from the Web Portal including: manual entry, EDI 810s, flat files, image only, spread-
sheet with images, ZIP files. It monitors a folder for the presence of files, and imports the invoices as pur-
chase batches when they are present. Completed files are moved from the import folder to a designated
backup folder, and in the event of import errors, moved to a designated error folder.

Setting Up the XML Invoice Importer - Engine

The following system preferences are necessary to successfully set up the XML Invoice Importer:

System Preferences

The following System Preferences must be set in the Identification/system constants, Interface para-
meters, Invoice XML Importer:

Preference Description

Folder to Watch Set folder location for XML zip files to be imported

Skip new debtor cre-
ation during import

If False, new debtors will be automatically created at the time of import if the
debtor information in the XML file does not match the debtor information in the
database

Allow incorrect totals If True, the import will allow XML files to import with incorrect file totals or batch
totals (Note: This preference should always be true if using the BatchPayout
fields within the XML file)

Allow missing images If True, the import will continue if images are missing

Successful import
report emails

Email address or addresses to receive successful import notifications by email
(Note: When using multiple email addresses, they should be separated by a
comma)

Failed import report
emails

Email address or addresses to receive failed import notifications by email
(Note: When using multiple email addresses, they should be separated by a
comma)

The following System Preferences must be set in the Identification/System constants, Performance,
Scanning:
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Preference Description

Maximum scanned
images per file

This preference should ALWAYS be set to 1. If blank, the default value is 1.

Optimize scanned
images

Set to True to run an optimization process on scanned images.

Recommended to reduce imaging issues.

The following System Preferences must be set in the Data entry behavior, Imaging:

Preference Description

PDF resolution value
for TIFF Conversion

It is strongly recommended that the preference is set to 96 or less.

If the resolution value is set to anything higher than 96 when using optimization, any ima-
ging issues will not be supported.

Select System Preference folder Data entry behavior, Purchase Entry, Imaging to set options for image
processing:

System Preferences Description

Default to support
instead of invoice

Set to True to default images to Support type instead of Invoice type during pur-
chase entry.

The following System Preferences must be set in the Data entry behavior, Intelligent data collection,
Invoices-interpretation:

Preference Description

Force all batches to
rework

Set to False for imported invoice's status that do not have rework conditions to
be Scanned/Ready to Post in the Manage Pending Purchase(F8) screen after
import and when reworked, any Auto Expense will auto populate.

Engine Task

The Folder Monitor Import Task is the only Engine task that must be setup for the Engine to import the XML
files once the system preferences above are set.

Invoice Importer Stand-Alone Program

To run the Invoice Importer:
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1. Open the fsInvImporter.exe application from the FactorSoft directory or desktop application.

The Invoice Importer application opens on the desktop.

2. Select the Database tab.

3. In the Format list, select the import format.

The Database tab fields are populated with the pre-configured values. For information on con-
figuring this tab, see Setting Up the Invoice Importer.

4. Select the Scanning tab.

5. Click the Start Scan button.

The Stoplight icon appears and the Stop scan button becomes active. When the Invoice Importer is
importing files, the stoplight will change to a green light, and the Abort button becomes available.
When idle, it is red.
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Stopping the Invoice Importer

To stop the Invoice Importer, click the Stop Scan button. The Start Scan and Exit buttons become avail-
able. To close the Invoice Importer application, click Exit.

FactorSoft XML File Description Engine

The FactorSoft XML format imports a ZIP file containing an XML file and image files. The XML contains
invoice data as well as the image cross references. The file can contain batches for multiple clients. Upon
import, a single purchase batch is created for each client with images attached. A description of the XML
file follows. A full sample follows the description.

File Element

There is only one <File> element is the root element of the file, occurs only once, and must bracket all other
elements of the file, with the closing tag </File> must be the final element of the file. The File element
serves as the file balancing header and contains the following attributes:

<File AllBatchCount="9999" AllBatchTotal="999999999.99">

<FileInfoGroup FileDate="YYYYMMDD" FileTime="999999"/>

Attribute Name Description

AllBatchCount The total number of invoices included in the file.

AllBatchTotal The total dollar amount of all invoices in the file.

FileInfoGroup

FileDate YYYYMMDD

FileTime HHMMSS

BatchRec Element

The BatchRec element is a child element within the File element. There are one to many BatchRec ele-
ments, each of which serves as a batch header to define the batch of invoice records that follow it. Each
batch record must end with the </BatchRec> closing tag. The BatchRec element contains the following
attributes:

<BatchRec BatchDollarTotal="999999999.99" PostDate="YYYYMMDD" InvoiceCount="9999" Cli-
entName="Lender's Client Name" ClientCode="Lender's Client Code">
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Attribute Name Description

BatchDollarTotal The total dollar amount of all invoices in the batch.

PostDate The posting date of the purchase transaction. YYYYMMDD.

InvoiceCount The total number of invoices included in the batch.

ClientName The client name.

ClientCode The client number.

BatchPayout Element

TIP
Must be processed by the Engine for this Element to be included.

The BatchPayout element is a sub-child element within the BatchRec element. There are one to many
BatchPayouts elements, each of which defines the Payout detail to be imported. The BatchPayout ele-
ment contains the following sub-child elements:

<BatchPayouts>

<BatchPayout>

<AcctName1>Account Name 1</AcctName1>

<Amount>123.45</Amount>

</BatchPayout>

</BatchPayouts>

Attribute Name Description

AcctName1 The Client’s Bank Relationship Account Name

Amount The Payout Amount

Invoice Element

The Invoice element is a sub-child element within the BatchRec element. There are one to many Invoice
elements, each of which defines the invoice detail to be imported. The Invoice element contains the fol-
lowing sub-child elements:
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InvoiceHeader

The invoice header contains the following tags. There is only one per Invoice element. The actual data
must be specified within an opening and closing tag:

<InvoiceHeader>

<InvoiceNumber></InvoiceNumber>

<InvoiceDate></InvoiceDate>

<InvoiceAmount></InvoiceAmount>

<PONumber></PONumber>

<DaysDue></DaysDue>

<Description></Description>

<FreightAmount></FreightAmount>

<CptCode></CptCode>

<Contract></Contract>

</InvoiceHeader>

Tag Name Description

InvoiceNumber The invoice number for each invoice to be entered in the batch

InvoiceDate The invoice date.

InvoiceAmount The invoice amount.

PONumber The purchase order or other reference document number.

DaysDue The due days set for the invoice.

Description Any additional invoice-related information, such as the bill of lading or
trailer numbers.

Freight Amount The amount of freight included in the Invoice amount. If there is no
freight amount, omit this attribute from the file to prevent import fail-
ure.

CptCode The CPT code associated to the client for invoices. This value must
match exactly to be imported.

Contract The Contract number associated to the client for invoices. This value
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Tag Name Description

must match exactly to be imported.

Debtor Element

The Debtor sub-child element contains the following attributes and tags. There is only one per Invoice ele-
ment. The actual attribute data must be enclosed in quotation marks, while the data must be specified
within an opening and closing tag:

<Debtor ClientRefNo="AAAAAAAAAAAA" DebtorCode="AAAAAAAAAAAA" DebtorName="Lender's
Debtor Name">

<DebtorAddress>

<Addr1>123 Main Street</Addr1>

<Addr2>Suite 475</Addr2>

<City>AnyTown</City>

<State>ST</State>

<PostalCode>99999-9999</PostalCode>

<Country></Country>

</DebtorAddress>

<DebtorAdditionalInfo>

<MCNumber></MCNumber>

<Email></Email>

<Phone></Phone>

<Fax></Fax>

<Attention></Attention>

</DebtorAdditionalInfo>

</Debtor>

Name Description

Debtor Tag Attributes

AutoInvoice User Guide
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Name Description

ClientRefNo The Client Reference Number (that is, the number or code used to
identify this debtor by your client).

DebtorCode The debtor code used to identify this debtor in FactorSoft.

DebtorName The customer/debtor name.

<DebtorAddress> sub-child element tags:

Addr1 The first line of the debtor street address.

Addr2 Additional address information (Suite, Building, etc.) of the debtor
address.

City City component of the debtor address.

State State code.

PostalCode ZIP Code/postal code components of the debtor address.

Country Country component of the debtor address.

<DebtorAdditionalInfo> sub-child element tags:

MCNumber The debtor's motor Carrier number.

Email The debtor's email address.

Phone The debtor primary phone number.

Fax The debtor's fax phone number.

Attention The name to appear in the address attention line.

CarrierPayment Element

The CarrierPayment sub-child element contains the following tags. There is only one per Invoice element.
The actual data must be specified within an opening and closing tag.

<CarrierPayment>

<CarrierCode></CarrierCode>

<CarrierName></CarrierName>

<CarrierTerm></CarrierTerm>
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<CarrierGrossAmt></CarrierGrossAmt>

<CarrierPreviousAmt></CarrierPreviousAmt>

<CarrierInvNo></CarrierInvNo>

</CarrierPayment>

Tag Name Description

CarrierCode The carrier code.

CarrierName The carrier name.

CarrierTerm The carrier terms applied to the Carrier Payment.

CarrierGrossAmt The dollar amount of the carrier payment on the invoice. This is the
gross amount of the payment before fees are assessed and previous
payments deducted.

CarrierPreviousAmt The previous payment amount to be subtracted from the Carrier Pay-
ment.

CarrierInvNo The Document number (Doc#) assigned to the Carrier Payment.

Images Element

The Images sub-child element contains the following tags. There is only one per Invoice element. The
actual data must be specified within an opening and closing tag.

Without Image Type Attribute:

<Images NumberOfImages="9999">

<ImageNameInvoice></ImageNameInvoice>

<ImageNameBackup></ImageNameBackup>

</Images>

With Image Type Attribute:

TIP
Must be processed by the Engine for this Element to be included.

<Images NumberOfImages=" 1">

<ImageNameBackup ImageType="0">backup_documents_11536494.pdf</ImageNameBackup>
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</Images>

Name Description

Tag Attributes

Number of images The number of image records for the invoice.

Tags

ImageNameInvoice The external file name of the invoice image file.

ImageNameBackup The external file name of non-invoice (supporting docs) image file.

ImageType The Image Code

Setup in Tables > Data Entry > Image Type Table > Image Tab

Unassigned Images Element

The Unassigned Images sub-child element contains the following tags. There are one to many Unas-
signed Images per BatchRec element. The actual data must be specified within an opening and closing
tag.

Without Image Type Attribute:

<UnassignedImages NumberOfImages=" 1">

<UnassignedImage>dd9491a5-bbdd-46a4-9f5c-c86bd3845a7e.pdf</UnassignedImage>

</UnassignedImages>

With Image Type Attribute:

TIP
Must be processed by the Engine for this Element to be included.

<UnassignedImages NumberOfImages=" 1">

<UnassignedImage ImageType="3">dd9491a5-bbdd-46a4-9f5c-c86b-
d3845a7e.pdf</UnassignedImage>

</UnassignedImages>
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Name Description

Tag Attributes

Number of images The number of unassigned images in the batch.

UnassignedImage The external file name of the unassigned image file.

ImageType The Image Code

Setup in Tables > Data Entry > Image Type Table > Image Tab

FactorSoft XML Sample

AnyDoc File Description

The Anydoc EXCHANGEit GTO option imports a .GTO file, which is a text file containing one batch control
record and one-to-many invoice detail records, including image cross-references, in an ASCI text
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document. The image files are downloaded to the input directory with the .GTO file in .tif format.

Batch Control Record

A batch control record precedes the invoice detail records. A sample is pictured below, followed by
description of the fields utilized by FactorSoft:

Field Name Description

static1-BC:999 Client Number, where "999" is the actual client number.

B_DATE-BC:CCYYMMDD Batch Date

ENTER TOTAL INVOICES -
BC:999999999

Batch total dollar amount, decimal implied, where 999999999 is the
actual total of all invoices to follow.

B_NBR_OF_DOCS-BC:99 Total number of invoices and image files, where 99 is the actual
number of files.

N:\\invoices\03273049.tif Path to first image file

Invoice Detail Records

An invoice detail record is included for each invoice in the batch, followed by all associated image file ref-
erences. A sample is pictured below, followed by description of the fields utilized by FactorSoft:
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Field Name Description

ACCOUNT NUMBER-NW Client Reference Number (CliRefNo). 30 digit maximum after colon, left
zeros trimmed.

INVOICE NUMBER-NW Invoice Number. 11 digit maximum after colon, left zeros trimmed.

TOTAL-NW Invoice total dollar amount. Nine digit maximum after colon, decimal
implied, left zeros trimmed..

PO NUMBER-NW Purchase Order Number. 16 digit maximum after colon, left zeros
trimmed.

Aceline File Description

The Aceline import file is a ZIP file containing two comma-separated, quote delimited file and must follow
the naming conventions and file specifications as outlined below.

Invoice Data File

File name = CliNo_RI_yymmdd_s.csv where:

l CliNo = FactorSoft Client Number - (Aceline uses SCAC Codes)

l yymmdd = processing date

l s = sequence number for intraday files
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Column
Column Header
Name

Max
Length

Required Description

1 Client No 12 no Must match to a Client Number in FactorSoft

2 Client Name 30 no Must match to the Client Number passed in
field 1

3 Invoice Number 12 no

4 Invoice Date 10 yes CCYYMMDD

5 Shipper Number 10 yes Not Used

6 Shipper Name 30 no Not Used

7 Shipper Address 1 25 no Not Used

8 Shipper Address 2 25 no Not Used

9 Shipper City 15 no Not Used

10 Shipper State 2 no Not Used

11 Shipper Zip/postal
code

10 no Not Used

12 Shipper Country
Code

3 no Not Used

13 Consignee Number 10 no Not Used

14 Consignee Name 30 no Not Used

15 Consignee Address
1

25 no Not Used

16 Consignee Address
2

25 no Not Used

17 Consignee City 15 no Not Used

18 Consignee State 2 no Not Used

19 Consignee Zip/-
postal code

10 no Not Used

20 Consignee Country
Code

3 no Not Used
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Column
Column Header
Name

Max
Length

Required Description

21 Debtor Number 10 no FactorSoft Client Reference Number /
Account Number

22 Debtor Name 30 no

23 Debtor Address 1 25 no Not required, but preferred

24 Debtor Address 2 25 no Not required, but preferred

25 Debtor City 15 no Not required, but preferred

26 Debtor State 2 no Not required, but preferred

27 Debtor Postal/Zip
Code

10 no Not required, but preferred

28 Debtor Country 3 no ISO Country Code

29 Date Shipped 10 no Not Used

30 Reference Number 12 no PO number (repeated in field 39)

31 Customer Refer-
ence Number 2

12 no Not Used

32 Customer Refer-
ence Number 3

50 no Not Used

33 Assignment Stamp
Line1

40 no Not Used

34 Assignment Stamp
Line2

40 no Not Used

35 Assignment Stamp
Line3

40 no Not Used

36 Assignment Stamp
Line4

40 no Not Used

37 Assignment Stamp
Line5

40 no Not Used

38 Assignment Stamp
Line6

40 no Not Used
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Column
Column Header
Name

Max
Length

Required Description

39 Reference Number 25 no PO number (repeated from field 30)

40 Invoice Amount 11 yes Decimal included, do not zero pad

41 Driver 25 no Not Used

42 Tractor number 10 no Not Used

43 Trailer Number 10 no Not Used

44 Miles 6 no Not Used

45 Record Type 2 no Not Used

Image Reference File

File name = CliNo_XR_yymmdd_s.csv where:

l CliNo = FactorSoft Client Number - (Aceline uses SCAC Codes)

l yymmdd = processing date

l s = sequence number for intraday files

Column
Column Header
Name

Max
Length

Required Description

1 Client No 4 yes

2 Invoice Number 12 yes

3 Image Name 20 yes

4 Image Type 1 yes I = Invoice

B = Supporting document

O = Other

5 Reference Number 15 no PO Number

System Preferences

The following System Preferences must be set in the Identification/system constants, Interface para-
meters, Aceline Import parameters:
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Preference Description

Folder to Watch Set folder location for Aceline files to be imported

Successful import
report emails

Email address or addresses to receive successful import notifications by email
(Note: When using multiple email addresses, they should be separated by a
comma)

Failed import report
emails

Email address or addresses to receive failed import notifications by email
(Note: When using multiple email addresses, they should be separated by a
comma)

Engine Task

The Folder Monitor Import Task is the only Engine task that must be setup for the Engine to import the
Aceline files once the system preferences above are set.

AnyApp File Description

The AnyApp Invoice GTO option imports a .GTO file, which is a text file containing one batch control record
and one-to-many invoice detail records, including image cross-references, in an ASCI text document.
The image files are downloaded to the input directory with the .GTO file in .tif format.

Batch Control Record

A batch control record precedes the invoice detail records. A sample is pictured below, followed by
description of the fields utilized by FactorSoft:
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Field Name Description

Dealer ID-BC:000 Client Number, where "000" is the actual client number.

B_DATE-BC:CCYYMMDD Batch Date

ENTER TOTAL INVOICES -
BC:999999999

Batch total dollar amount, decimal implied, where 999999999 is the actual
total of all invoices to follow.

B_NBR_OF_DOCS-
BC:99

Total number of invoices and image files, where 99 is the actual number of
files.

N:\<folder path>\<im-
age file name>.tif

Path to first image file

Invoice Detail Records

An invoice detail record is included for each invoice in the batch, followed by all associated image file ref-
erences. The invoice records are delimited by the F:recourse records in the file. A sample is pictured below,
followed by description of the fields utilized by FactorSoft:
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Field Name Description

ACCOUNT NUMBER-TZ Client Reference Number (CliRefNo). 30 digit maximum after colon, left
zeros trimmed.

INVOICE NUMBER-TZ Invoice Number. 11 digit maximum after colon, left zeros trimmed.

INVOICE_TOTAL-TE Invoice total dollar amount. Nine digit maximum after colon, decimal
implied, left zeros trimmed..

PO NUMBER-TZ Purchase Order Number. 16 digit maximum after colon, left zeros
trimmed.
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AutoInvoice Audit Report

The AutoInvoice Audit Report is accessed from the Audit Reports menu of the Reports module for imple-
mentations of FactorSoft that utilize the AutoInvoice AddOn module, and to summarize the purchases and
invoices imported into FactorSoft using the AutoInvoice module. The report request screen contains both
a Summary and Detail format.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

AutoInvoice User Guide
AutoInvoice Audit Report

23 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Field Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Date
Range

Select the date to use for the report from the list:
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Field Description

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

Format Select the report format to generate:

l Detail

l Summary
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Report Samples

Detail Report
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Summary Report

Report Details

Column Description

Detail Format

Client Client's name

Invoice Number Invoice number

Debtor Debtor's name

Invoice Date Date of the invoice

Invoice Amount Amount of the invoice

Summary Format

Client Client's name

Invoice Count Number of Invoices imported for the Client

Amount Total dollar amount invoices imported for the Client

Security Roles

To generate the AutoInvoice Audit Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Audit Reports > AutoInvoice Audit Report
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